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Online Lab: Simulating Ray Optics 
 

The Basics 
 
All of our analysis of the physics of vision — lenses, mirrors, and images — follow from the careful 
application of a few basic principles: 
 
The general physics: 

● Certain objects (the sun, bulbs, etc) give off or emit light. 
● Through empty space (or air) light travels in straight lines. 
● Each point on a normal object scatters light, spraying it off in all directions. 
● A polished surface however reflects light rays according to the law of reflection:   

The angle of incidence equals the angle of reflection. 
 
The physics of a thin lens (based on some easy-to-figure out rays): 

● Rays that pass through the center of the lens go straight through. 
● Rays coming at the lens perpendicular to plane of the lens, or parallel to the principal axis (the 

line perpendicular to the lens surface and through the center of curvature of the lens) are kinked 
so they go through a single point on the far side of the lens known as the focal point. The focal 
point is a fixed distance from the lens (called the focal length) that depends on the curvature of 
the lens surface. 

● A thin lens has focal points on both sides of the lens, each at the same distance from the lens. 
 
The psycho-physiology: 

● We only see something when light rays coming from it enter our eyes. 
● Our eyes identify a point as being “on an object” when rays traced back converge at that point.  

If there is no actual object at that point, we call the convergence point an image of the original 
source. The image is found there due to additional factors we will explore later. 

● Your brain constructs your visual field using the assumptions that (1) light travels in straight lines 
and (2) sources are found where the rays trace back to, so it looks to us as if the source is at the 
position of the image. 

o We use other clues as well – and some people’s brains do not merge binocular vision. 
We won't consider those in this lab. 

 

The Simulation 
 
We will explore the way light behaves and the rules described above using mirrors and thin lenses by 
using a ray optics simulation at 
 
  https://ricktu288.github.io/ray-optics/simulator/ 
 
 
This program lets you do a lot, but it is fairly complex to use. Spend the next 10 minutes individually 
exploring what you need to do to create, delete, and move around  
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● The sources — a single light ray, a beam of rays, a point source of light 
● The measuring tools — a ruler and a protractor 
● The devices — a flat mirror (Mirror → Segment) and a thin lens (Glasses → Ideal lens).  

o You can create many other things, but these will be plenty. 
● The views — Rays, Extended Rays, All Images, and Seen by Observer 

o At first only use the Rays view. After you have created images with a mirror or a lens, 
explore the other views and figure out what they do. 

● Hint: Once you have placed objects and rays, to get the program to stop controlling them and let 
you just scoot the constructed objects around, choose "Move view". You can then move the 
object and source you placed, or the entire view. 

 
After you have explored individually, get together with your group and share what you have learned 
about how to use the program. 
 

The Tasks 
 
Mirror 
1. Create a single ray and a mirror segment, placed so that the ray is above the mirror and hits the mirror 
at an angle. Move the ray source around and observe what happens to the ray. Measure the angles of 
incidence and reflection for a number of rays and see if the program correctly represents the basic mirror 
principle given under "The Basics." Describe your results. 
 
2. Create a second ray and move it so that it comes from the same source as your first ray but goes out at 
a (slightly) different angle. Now turn on Extended rays.  

● Why did the program choose to extend the reflected rays rather than the rays coming directly 
from the source? What do these extensions represent? 

● Describe how an observer looking at the reflected rays would interpret what she is seeing. 
● Measure the distance from the mirror of both the ray source and the image of that source in the 

mirror; confirm that the image is the same distance behind the mirror as the source is in front of 
it. 

 
3. Move your source rays so that they are not directly in front of the mirror but instead off to the side, but 
also so that both rays still hit the mirror.  

● Is there still an image even though the source is not directly in front of the mirror? Use the ruler 
to measure where the image is with respect to where the source and mirror are. Do you get the 
result that the image is the same distance from the mirror as the source? If not, why not? 

● Include a screen capture of your diagram in your report. 
 
4. Choose “Reset” from the File menu to clear the simulation and make a new setup using a point source 
and a mirror segment similar to the one you used in part 2. 

● Move the point source around, observing where the reflected rays go. Where does an observer 
need to be in order to see the reflected rays? 

● Now turn on Extended rays. Move the source around and see where the image moves.  
The reflected rays look curved. Is this real or an optical illusion? Do a measurement using 
"Ruler" to decide. 

● Come up with a coherent description of where an observer needs to be in order to see the image 
in the mirror. 

● Include a screen capture of your diagram in your report. 
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5. For this part of the lab, you will use the 
simulation to study the question “How big a mirror 
do you need to see your full body?” Start by 
making a prediction, discussing it, and including 
your predictions in your report. You don't all have 
to agree, but give the reasons why if you disagree. 
 
To explore this, set up the following screen with a 
mirror two point sources to represent the top of 
your head and your feet and a mirror the same 
height as “you”. With rays turned on, your screen 
should look like the figure at the right. 

● Turn on extended rays to see where the 
images of your two sources form. 

● Now switch to the "All Images" view. This eliminates all the confusing rays and shows only 
where the sources (green) and images (red) are. Which image corresponds to which source? How 
can you tell? 

● Now switch to the "Seen by Observer" view. This shows a blue dot that corresponds to the eyes 
of an observer. Move it around. Can you place the observer so that he sees only 1, 2,  or 3 sources 
by going to different places? Describe where and why or why not. 

● Now let the blue Observer dot represent your own eyes by putting it just below the top of your 
“head” source. The choose "Move view" so you can click on the mirror to move it or change its 
size. Answer the following questions, explain your answers, and include at least one screenshot to 
support your explanations. 

1. In the position that you started with, how big a mirror do you need to see all of yourself?  
(Give an answer as a fraction of your height.) 

2. As you move the mirror closer or farther away (but still parallel to your body) how does 
the answer to 1. change? 

 
Share your results and discuss your conclusions as a class. 
 
Lens with point sources 
Reset your screen again by choosing "Reset" 
from the File menu. 
 
1. Place a single ray and a vertical lens by 
choosing "Ray" then "Glasses → Ideal lens" 
from the Tools menu. Arrange the ray so that 
it goes through the lens at an angle. Your 
screen should look like the figure at the right.  
 
Note that the ray has two red dots on it. If you 
move either red dot it moves the ray, keeping the 
other red dot fixed. If you grab the ray between the red dots, it moves the ray parallel to itself. 
 
Explore what happens as you move the ray in various ways and describe what you see. 
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2. Make sure the view is set on "Rays". Delete your original ray and put a point source to the left of the 
lens. The point where the refracted rays (the rays that go through the lens meet) is called a real image. 
Describe what you see as you move the source around.  
 
3. Keeping the source on the principal axis, place the source at many different distances (cover all the 
space) and collect data on distance of the source from the lens (x) and distance of the corresponding real 
image from the lens (y). Create a graph in Excel and include it in your report. 
 
4. At some distances from the lens you should not have found an image. Turn on the Extended rays in the 
view menu. You should now see that at those distances, while the refracted rays do not meet anywhere, 
the extended rays do. The point where the extension of these rays meet is called a virtual image. Take 
new data on the distances of the source and the corresponding virtual image from the lens. Create a graph 
in Excel and include it in your report. 
 
5. Now explore what an observer would see. This is considerably trickier than the mirror case! First place 
the source again so that there is a real image. Switch the view to "Seen by Observer" and explore what the 
observer sees when they are in various positions. Explain what the observer sees in various places and 
why. You might need to alternate between the "Extended rays" view and the "Seen by Observer" view to 
make sense of what you are seeing. 
 
Lens with an incoming beam of parallel rays. 
We'll now explore another feature of the lens by using a beam of parallel rays rather than a point source. 
 
1. Remove your point source and instead create 
a parallel beam by choosing "Beam" from the 
Tool menu and arranging the beam source 
(green line) so that it is parallel to your lens 
and aimed right at its center. Your screen 
should look like the figure at the right.  
 
You'll see that the lens brings all the parallel 
rays together at a single point. This is called the 
focal point or focus of the lens, and the distance 
from the focal point to the lens is called 
the focal length. 
 
Measure the focal length using a ruler and 
report your result. Now turn the ruler vertical 
and put it at the focal point. Your screen should 
look like the figure at the right.  
 
Now move the beam up and down and left and 
right. Describe what happens to the focal point. 
 
Then move the beam every which way, tilting it 
as well as moving it. Describe what happens to 
the focal point. 
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2. In the previous section you generated a series of object distance / image distance pairs for the case of a 
real and virtual image. For a lens, we will derive in class that these distances are supposed to satisfy a 
relation like 
 

1/(object distance)  + 1/(image distance)  = 1/(focal length) 
 
Do your data sets agree with this relation? Create tables in Excel to check and discuss your results with 
the whole class. Include your tables in your report. 
 
3. For this next part we want to measure the size of the object and image, so we need to have a more 
carefully created setup. Delete all your objects and start again (Reset). 

● Create a new lens. You can assure that it is vertical by holding the shift key while you draw it. 
● Draw a ruler starting from the center of the lens and pulling out to the right while holding the 

shift key to make it horizontal (for measuring the image distance). 
● Draw a similar ruler to the left by starting at the center and pulling to the left (for measuring the 

object distance). 
Your screen should look like the figure below. (You may have to draw the rulers somewhere else and 
then move them into place.) 
 

 
 
Now place a vertical ruler at some distance on the left, beyond the focal point, going up. We will be using 
this location for the object distance. Put a point source somewhere along the ruler and so that there is an 
image. Determine the image distance, and put a ruler at that location, but going down. Switch to "All 
Images" view, and you should see something like what is shown below. Don’t worry if your object and 
image distances are different from what is shown here. 
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We are going to be interpreting the point source distance from the principal axis as the object height and 
the image distance from the axis as the image height as shown in the figure below, where the object (on 
the left) and the image (on the right) are represented by arrows. 
 

 
 
Make a plot of the image height vs the object height for a few different object distances. 
 
Share your results with the full class. From the many different results found, can you determine what 
controls the slopes of your different plots and generate an equation that correctly summarizes everyone's 
graphs of image vs object sizes? 
 
4. When the size of the image is larger than the size of the object, you can use the lens to see small things 
more clearly (magnifying glass). From your analysis of the previous problem, what distances are the best 
for using a lens to magnify an object? 

If you have time 
 
If you have time, you might find it interesting to explore the combination of two lenses and how they can 
magnify an object. 


